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2 About Your Product

About Your Product

After you set up your Artisan® 730 (see the Start Here sheet), turn to this Quick Guide and 
your online User’s Guide for instructions on using your product.

Adjusting the Control Panel

The control panel is adjustable. Raise or lower it to the desired angle as shown.

Features Where to find information

Copy and scan from the easy-to-use touch 
panel.

See this Quick Guide for the basics. See 
the online User’s Guide for details.

Easy networking—Wi-Fi and Ethernet®. See the Start Here sheet and the online 
User’s Guide.

Print photos from a USB flash drive, external 
hard drive, or CD burner.

See the online User’s Guide for details.

Create professional coloring books, greeting 
cards, note paper, and more.

Copy files to and from your computer with the 
built-in memory card reader.

Wireless printing from mobile devices with 
Epson Connect.

See www.epson.com/connect
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Using the Touch Panel

The touch panel makes it easy to use all the features of your product. To save energy, the 
screen goes dark after several minutes of inactivity. Touch the screen to wake it up.

Caution: Press the touch panel gently with the tip of your finger; don’t press too hard 
or use sharp objects.

The touch panel displays only the buttons that are available for the task you are working 
on.

■ Press l or r to view more photos or access more options.

■ Press Home to return to the Home screen.

Number Description

1 Turns product on/off

2 Returns to the Home menu

3 Changes the view of photos or crops photos

4 LCD screen shows menus and status

5 Sets the number of copies

6 Use the arrow keys and OK button to navigate menus

7 Stops copying/printing/scanning or resets settings

8 Shows wireless network status

9 Ejects and closes the CD/DVD tray

10 Blue status light

11 Displays detailed settings for each mode

12 Cancels/returns to the previous menu

13 Starts copying/printing/scanning

Menu Back Start

Stop
Reset

CD Tray

Display
Crop

Home

2 3 4 5 6 7

12111098 13

1
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■ Press x Menu to make special settings. The touch panel retains the settings from the 
last time it was used. If you want to start over, simply press y Stop/Reset to clear 
settings for the mode you’re using.

■ The blue status light at the bottom of the touch panel flashes when the product is 
printing or performing routine maintenance. If it flashes rapidly, check the product 
for error messages.

Tip: To turn off the “beep” heard when you press a button, or to reduce its 
volume, press l or r to select Setup, press OK > Printer Setup > OK > Sound 
> OK, and adjust one of the settings.

You may see the following icons on the screen:

Icon Meaning

The product is connected to a wired network.

The product is connected to a wireless network.
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Using Special Papers

Epson offers a wide array of high quality papers, making it easy to maximize the impact of 
your documents, photos, presentations, and creative projects.

You can purchase genuine Epson ink and paper at Epson Supplies Central® at 
www.epson.com/ink3 (U.S. sales) or www.epson.ca (Canadian sales). You can also 
purchase supplies from an Epson authorized reseller. To find the nearest one, call 800-GO-
EPSON (800-463-7766).

Paper name Size

Part 

number

Sheet 

count

Epson Ultra Premium Photo Paper 
Glossy

4 × 6 inches (102 × 152 mm) S042181
S042174

60
100

5 × 7 inches (127 × 178 mm) S041945 20

8 × 10 inches (203 × 254 mm) S041946 20

Letter (8.5 × 11 inches 
[216 × 279 mm])

S042182
S042175

25
50

Epson Ultra Premium Photo Paper 
Luster

Letter (8.5 × 11 inches 
[216 × 279 mm])

S041405 50

Epson Premium Photo Paper 
Glossy

4 × 6 inches (102 × 152 mm) S041808
S041727

40
100

5 × 7 inches (127 × 178 mm) S041464 20

8 × 10 inches (203 × 254 mm) S041465 20

Letter (8.5 × 11 inches 
[216 × 279 mm])

S042183
S041667

25
50

Epson Premium Photo Paper Semi-
gloss

4 × 6 inches (102 × 152 mm) S041982 40

Letter (8.5 × 11 inches 
[216 × 279 mm])

S041331 20

Epson Photo Paper Glossy 4 × 6 inches (102 × 152 mm) S041809
S042038

50
100

Letter (8.5 × 11 inches 
[216 × 279 mm])

S041141
S041649
S041271

20
50
100

Epson Ultra Premium Presentation 
Paper Matte

Letter (8.5 × 11 inches 
[216 × 279 mm])

S041341 50

Epson Premium Presentation Paper 
Matte

8 × 10 inches (203 × 254 mm) S041467 50

Letter (8.5 × 11 inches 
[216 × 279 mm])

S041257
S042180

50
100

Epson Premium Presentation Paper 
Matte Double-sided

Letter (8.5 × 11 inches 
[216 × 279 mm])

S041568 50
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Note: Media availability varies by country.

For detailed paper loading instructions, see the Start Here sheet or online User’s Guide.

For best results:

■ Load letterhead or pre-printed paper facedown, with the top edge at the back of the 
paper cassette, making sure the paper is under the edge guides.

■ Make sure the paper stack fits under the left and front edge guides.

■ Insert photo paper with the glossy or printable side facedown, making sure the paper 
is under the edge guides.

Epson Presentation Paper Matte Letter (8.5 × 11 inches 
[216 × 279 mm])

S041062 100

Legal (8.5 × 14 inches 
[216 × 356 mm])

S041067 100

Epson Bright White Paper Letter (8.5 × 11 inches 
[216 × 279 mm])

S041586 500

Epson Photo Quality Self-adhesive 
Sheets

A4 (8.3 × 11.7 inches 
[210 × 297 mm])

S041106 10

Epson Iron-on Cool Peel Transfer 
paper

Letter (8.5 × 11 inches 
[216 × 279 mm])

S041153 10

Paper name Size

Part 

number

Sheet 

count



Copying a Document or Photo 7

Copying a Document or Photo

Follow the instructions in this section to position your originals correctly on the scanner 
glass and make color or black-and-white copies.

1. Make sure paper is loaded.

2. Open the document cover and place your original facedown on the scanner glass, with 
the top against the back left corner.

3. Close the cover gently so you don’t move the original.

4. Press Home if necessary, press l or r to select 
Copy, then press OK. You see this screen.

5. Press + or – to select the number of copies you want.

6. Press u or d to select Color or B&W (black and white) 
copies.

7. Press l or  r to adjust the Density (make the copies 
lighter or darker) if necessary.

8. To change copy settings, press x Menu, select Paper 
and Copy Settings, then press OK.

■ To print on both sides of the page, turn on 
2-Sided Printing.

■ Press u or d to select your Layout and Paper 
Size settings.

■ To adjust the copy size, select Reduce/Enlarge, 
press OK, then select Actual Size (to print at actual size), Custom Size (to select 
a percentage), Auto Fit Page (to automatically size the image to fit your paper), 
or one of the specific sizes listed.
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■ Select your Paper Type.

■ For the Document Type setting, choose Text for plain documents or 
Text & Image if your document contains photos or graphics.

■ To change the copy quality, select Quality, press OK, then choose Draft, 
Standard Quality, or Best.

Note: To clear previously used copy settings, press y Stop/Reset. For more 
information about copy settings, see your online User’s Guide.

9. Press x Start to begin copying. To cancel copying, press y Stop/Reset.
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Printing From a Memory Card

Your product lets you print photos directly from your digital camera’s memory card; just 
insert it into the memory card slot and you’re ready to print.

See the online User’s Guide for instructions on copying memory card files between your 
product and a computer, and printing photos directly from your camera.

Inserting the Card

1. Make sure the product is turned on.

2. Insert your card into the correct slot as shown. Insert 
just one card at a time. For a list of compatible 
memory cards, see the online User’s Guide.

Caution: Do not force the card into the slot; it 
won’t go in all the way. If your memory card 
requires an adapter, attach it before inserting the 
card into the slot. Otherwise, the card might get 
stuck.

The memory card access light flashes, then stays lit. Now you can view your photos on the 
LCD screen and print them (see page 10).

Removing the Card

After you finish printing your photos, follow these steps to remove the card:

1. Make sure the memory card access light is not flashing.

Caution: Do not remove the card or turn off your printer while the memory card 
access light is flashing; you may lose data on the card.

2. If the product is connected to your computer with a USB cable, do one of the 
following before removing the memory card or turning off the printer:

■ Windows®: Right-click the name of your card (removable disk) in My Computer 
or Windows Explorer, and select Eject.

■ Mac OS® X: Drag the removable disk icon from your desktop into the trash, 
then remove the card.

3. Pull the card straight out of its slot.

Memory card 
access light
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Printing Photos From the LCD Screen

You can select individual photos for printing as you view them on the LCD screen. See the 
online User’s Guide for instructions on printing photo greeting cards, layout sheets, and 
proof sheets.

1. Load several sheets of Epson photo paper in the cassette.

2. Press the Home button, if necessary, press l or r to select Print Photos, then 
press OK.

3. Select View and Print Photos, then press OK.

4. Press u or d to turn Auto Correct on or off.

5. Press l or r to scroll through your photos and display 
one that you want to print.

6. Press + to select the photo for printing.

7. To print more than one copy, press + or – to select the 
number of copies you want of that photo.

To crop the photo, press  Display/Crop. Press + or – to frame the image; use the 
arrows to move the frame. Press OK twice when done.

8. Repeat steps 5 to 7 to select more photos.

9. Press x Menu, press u or d to select Print Settings, 
then press OK.

10. Select your Paper Size, Paper Type, Quality and 
other print settings, then press x Menu, then OK to 
confirm your settings.

11. When you’re ready to print, press x Start.

To cancel printing, press y Stop/Reset.
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Printing From Your Computer

This section describes the basic steps for printing from a Windows or Mac® computer. For 
detailed instructions on printing, see the online User’s Guide.

The auto duplexer lets you print on both sides of the page automatically. You can use the 
auto duplexer with letter- or A4-size plain paper or Epson Bright White Paper. For 
detailed instructions on two-sided printing from Windows or Mac OS X, see the online 
User’s Guide.

Printing in Windows

1. Select the print command in your application. You see a window like this one:

2. Make sure your product is selected, then click the Preferences or Properties button.

(If you see a Setup, Printer, or Options button, click it. Then click Preferences or 
Properties on the next screen.)

Click here to open 
your printer software

Select your Epson 
product
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3. On the Main tab, select the basic print settings. Make sure you choose the correct 
paper Type setting for the paper you are using (see page 14 for details).

Note: For quick access to the most common settings, click the Shortcuts tab and 
select one of the presets. You can create your own presets by clicking the Save 
Settings button on the Advanced tab.

4. To improve the color, contrast, and sharpness of photos, select Fix Photo.

5. To reduce or remove red-eye effects in photos, select Fix Red-Eye.

6. If you want to reduce or enlarge your printout, click the Page Layout tab and select 
settings as necessary.

7. For more printing options, click the Advanced tab.

Note: For more information about print settings, click Help or see your online 
User’s Guide.

8. Click OK to save your settings.

9. Click OK or Print to start printing.

Select your 
document or photo
Orientation

Select your 
paper Size

Select your 
paper Type 

Select the type of document you’re 
printing (choose Photo or Best 
Photo for pictures)
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Printing with Mac OS X

Follow the steps below to print from Mac OS X 10.5 to 10.6. If you’re printing from 
Mac OS X 10.4, see your online User’s Guide for instructions.

1. Open a photo or document in an application.

2. Open the File menu and select Print.

3. Select your product as the Printer setting.

4. Select basic copy and page settings. For borderless printing, choose a Paper Size 
setting with a (Borderless) option.

Note: If the setting you want isn’t shown (for example, Scale), check for it in your 
application before printing. Or check for it in the settings for your application at the 
bottom of this window.

Click to expand, 
if necessary

Select your Epson product

Copy and page 
settings

Application 
settings

Pop-up menu
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5. Choose Print Settings from the pop-up menu, and select your Media Type, Print 
Quality, and other print settings.

6. Choose any other printing options you may need from the pop-up menu. See the 
online User’s Guide for details.

7. Click Print.

8. To monitor your print job, click the icon in the Dock.

Selecting the Correct Paper Type

Select the correct Type (Windows) or Media Type (Mac OS X) setting in your printer 
software. This tells your product what kind of paper you’re using, so the ink coverage can 
be adjusted accordingly. 

For this paper Select this setting

Plain paper
Epson Bright White Paper
Epson Presentation Paper Matte
Epson Iron-on Cool Peel Transfer paper
Epson Photo Quality Self-adhesive Sheets

Plain Paper/Bright White Paper

Epson Premium Photo Paper Glossy Premium Photo Paper Glossy

Epson Ultra Premium Photo Paper Glossy Ultra Premium Photo Paper Glossy

Epson Photo Paper Glossy Photo Paper Glossy

Epson Premium Photo Paper Semi-gloss Premium Photo Paper Semi-Gloss

Epson Premium Presentation Paper Matte
Epson Premium Presentation Paper Matte Double-

sided
Epson Ultra Premium Presentation Paper Matte

Premium Presentation Paper Matte

Envelopes Envelope
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Scanning a Document or 
Photo

You can use your product to scan original documents or photos and save them on your 
computer. The Scan function lets you scan quickly using preselected settings, or you can 
use the Epson Scan software to access more advanced features. For example, you can use 
Epson Scan to restore faded colors in old photos.

Note: For detailed scanning instructions, see the online User’s Guide.

Quick Scanning with the Touch Panel

Use the touch panel to quickly scan a photo or document and save it on your computer. 
You can even scan a photo and have it automatically included in an email message.

1. Open the document cover and place your original facedown on the glass, in the back 
left corner, as shown on page 7.

2. Close the cover gently so you don’t move the original.

3. Press Home, if necessary, press l or r to select Scan, then press OK.

4. Press u or d to select one of the following options:

■ Scan to Memory Card automatically scans a photo or document and saves it on 
a memory card or USB storage device in JPG or PDF format

■ Scan to PC automatically creates a JPG image and saves it to your computer; 
ideal for scanning photos

■ Scan to PC (PDF) automatically creates a PDF file and saves it to your 
computer; ideal for scanning documents

■ Scan to PC (Email) automatically scans a photo, resizes it, launches your email 
application, and attaches a JPG image to a new outgoing message

■ Scan to PC (WSD) lets you scan wirelessly in Windows 7 or Windows Vista® 
(English only)

5. Press OK.
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6. If you’re scanning to a memory card, select your scan settings then press x Start to 
begin scanning.

If you’re scanning to your computer, select USB Connection if your product is 
connected by a USB cable, or select the name of your computer if your product is 
connected over a network. Press OK to begin scanning.

Once your image is scanned, you see its icon in Windows Explorer or Mac OS X 
Finder, or as an attachment in your email application.

Scanning with Epson Scan Software

You can scan original documents and photos and save them as files on your computer 
using the Epson Scan software. You can also launch Epson Scan from any TWAIN-
compliant application, such as Adobe® Photoshop®.

Note: For Mac OS X 10.6, see “Scanning with Mac OS X 10.6” on page 17. For 
detailed scanning instructions, see the online User’s Guide.

1. Open the document cover and place your original facedown on the glass, in the back 
left corner, as shown on page 7.

2. Close the cover gently so you don’t move the original.

3. Do one of the following to start Epson Scan:

■ Windows: Double-click the EPSON Scan icon on your desktop.

■ Mac OS X 10.4 and 10.5: Double-click EPSON Scan in Applications > Epson 
Software.

■ To scan from an application, start your application. Then open the File menu, 
choose Import or Acquire, and select your product.

Epson Scan opens in Full Auto Mode the first 
time you use it. (You can change the scan mode 
using the Mode selector in the upper right 
corner.)

Note: If you want to automatically restore a 
color photo as you scan, click the Customize 
button, then check the Color Restoration box.

4. Click the Scan button. The image is scanned and 
you see its icon in Windows Explorer or Mac 
Finder.
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Scanning with Mac OS X 10.6

You can scan original documents and photos and save them as files on your computer.

1. Open an image editing application such as Image Capture, select your product, if 
necessary, then press the Scan button.

2. If you would like to select scan settings, such as Color Restoration and file save 
settings, click Show Details.

3. Click the Scan button to begin scanning. Your image is saved to the folder selected in 
the Scan To pop-up menu.
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Maintaining Your Product

Follow the instructions in this chapter for checking and cleaning the print head nozzles 
and replacing ink cartridges. To align the print head, if necessary, see your online User’s 
Guide.

Caution: To keep your product looking like new, don’t place anything on top of the 
cover or use it as a writing surface. If you need to clean the cover, use only a soft, non-
abrasive microfiber-type cloth.

Checking the Print Head Nozzles

If your printouts are faint or have gaps in them, some of the nozzles in the print head may 
be clogged or ink may be running low in one or more of the ink cartridges. Follow the 
steps below to check the print head nozzles.

1. Load letter- or A4-size plain paper in the main paper cassette.

2. Press Home, if necessary, press l or r to select Setup, then press OK.

3. Press u or d to select Maintenance, press OK, select Nozzle Check, then press OK 
again.

4. Press x Start.

5. Check the nozzle check pattern that prints to see if there are gaps in the lines:

6. If there are no gaps, the print head is clean. Select Finish Nozzle Check, then press 
OK.

If there are gaps or the pattern is faint, press u or d to select Head Cleaning, press 
OK, then press x Start to clean the print head (see page 19).

Nozzles 
are clean

Nozzles need 
cleaning
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Cleaning the Print Head

If print quality has declined and the nozzle check indicates clogged nozzles, you can clean 
the print head. Print head cleaning uses ink, so clean it only if necessary.

Note: You cannot clean the print head if an ink cartridge is expended, and may not be 
able to clean it when a cartridge is low. You must replace the cartridge first (see 
page 21).

1. Load letter- or A4-size plain paper in the main paper cassette.

2. Press Home, if necessary, press l or r to select Setup, then press OK.

3. Press u or d to select Maintenance, press OK, select Head Cleaning, then press OK 
again.

4. Press x Start.

Cleaning takes about 2 minutes. When it’s finished, you see a message on the display 
screen.

Caution: Never turn off the printer during head cleaning or you may damage it.

5. Select Nozzle Check, press OK, then press x Start to run a nozzle check and confirm 
that the print head is clean.

6. If there are still gaps or lines, or the test patterns are faint, run another cleaning cycle 
and check the nozzles again.

Note: If you don’t see any improvement after cleaning the print head four times, turn 
off the printer and wait at least six hours to let any dried ink soften. Then try cleaning 
the print head again. If quality does not improve, one of the ink cartridges may need to 
be replaced. If that doesn’t help, contact Epson as described on page 29.

If you do not use your product often, it is a good idea to print a few pages at least once 
a month to maintain good print quality.
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Checking Ink Levels

You can check the ink levels anytime right on the LCD screen. To check the ink levels 
with your Windows or Mac OS X software, see the instructions in your online User’s 
Guide.

Note: You cannot print or copy when an ink cartridge is expended even if the other 
cartridges are not expended. Replace any expended cartridges before printing or 
copying.

1. Press Home, if necessary, press l or r to select Setup, then press OK.

2. Press OK again to select Ink Levels.

3. The ink cartridge status is displayed. See page 21 to 
replace a cartridge, if necessary.

In Windows, a window may appear on your computer 
screen when you try to print when ink is low. This window 
can optionally display ink offers and other updates from 
Epson.

Note: To disable checking for ink offers or updates from Epson, see the instructions in 
your online User’s Guide.

Purchasing Epson Ink Cartridges

You can purchase genuine Epson ink and paper from Epson Supplies Central at 
www.epson.com/ink3 (U.S. sales) or www.epson.ca (Canadian sales). You can also 
purchase supplies from an Epson authorized reseller. To find the nearest one, call 800-GO-
EPSON (800-463-7766).
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Use the following list when you order or purchase new ink cartridges (you can mix 
Standard- and High-capacity cartridges):

Note: We recommend that you use genuine Epson cartridges and do not refill them. 
The use of other products may affect your print quality and could result in printer 
damage.

Yields vary considerably based on images printed, print settings, paper type, frequency 
of use, and temperature. For print quality, a small amount of ink remains in the cartridge 
after the “replace cartridge” indicator comes on. Your printer ships with full cartridges 
and part of the ink from the first cartridges is used for priming the printer.

For best printing results, use up a cartridge within six months of opening the package, 
and before the expiration date on the cartridge box.

Store ink cartridges in a cool, dark place. If cartridges have been exposed to cold 
temperatures, allow them to warm up to room temperature for at least 3 hours before 
using them.

Replacing Ink Cartridges

Make sure you have a new ink cartridge before you begin.

Caution: Do not open ink cartridge packages until you are ready to install the ink. 
Cartridges are vacuum packed to maintain reliability. Leave the expended cartridge 
installed until you have obtained a replacement, or the ink remaining in the print head 
nozzles may dry out.

1. Turn on your product.

2. If an ink cartridge is expended, you see a message on the 
LCD screen. Note which cartridges need to be replaced 
and press OK.

Note: If a cartridge is expended, you must replace it to 
be able to print. If a cartridge is low, you can continue 
printing until a cartridge needs replacement.

Ink color Standard-capacity High-capacity

Black — 98

Cyan 99 98

Magenta 99 98

Yellow 99 98

Light Cyan 99 98

Light Magenta 99 98
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3. Open the scanner.

4. Squeeze the tab on the cartridge and lift it up. Dispose of it 
carefully. Do not take the used cartridge apart or try to refill 
it.

Warning: If ink gets on your hands, wash them thoroughly 
with soap and water. If ink gets into your eyes, flush them 
immediately with water. Keep ink cartridges out of the 
reach of children and don’t drink the ink.

5. Remove the new cartridge from its package.

6. Remove the yellow tape from the bottom of the 
ink cartridge.

Caution: Do not remove any other labels or 
seals, or ink may leak. Do not touch the green 
chip on the front of the cartridge. This can 
damage the ink cartridge.
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7. Insert the new cartridge into the holder and push it down until it clicks into place.

8. Once you replace all the cartridges that need replacing, close the scanner to begin 
charging the ink. This takes about 2 minutes. When you see a completion message on 
the display screen, ink charging is finished.

Caution: Never turn off your product while ink is charging or you’ll waste ink. If you 
see an ink replacement message on the LCD screen, press OK and press down all 
the cartridges securely. If you remove a low or expended ink cartridge, you cannot 
reinstall and use the cartridge.

Note: If you replaced a cartridge while copying a document or photo, cancel 
printing and make sure your original is still placed correctly on the document table. 
Then copy your original again.
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Solving Problems

Check the messages on the display screen to diagnose the cause of most problems. Press 
Home, if necessary, press l or r to select Problem Solver, then press OK. Press u or 

d to see all the help topics.

You can also check the basic troubleshooting suggestions below, or your online User’s 
Guide.

Problems and Solutions

Check the solutions below if you’re having trouble using your Epson product.

Note: If the screen is dark, press the touch panel to wake up the printer.

Network Problems

If you have a poor wireless connection, try moving the product to a different location. 
Avoid placing it next to a microwave oven, 2.4 GHz cordless phone, or large metal object 
such as a filing cabinet.

Network setup failed

■ Try moving the product to a different location.

■ Make sure there aren’t any access restrictions (such as MAC address filtering) set on 
the wireless router. If access restrictions are set, register the product’s MAC address on 
the router. To obtain the MAC address, print a Network Status Sheet (see page 26). 
Then see your router’s manual for instructions.

■ If your wireless router or access point doesn’t broadcast its network name (SSID), 
manually enter your wireless network name. If your wireless router or access point has 
wireless security enabled, you will also need to know what kind of security it is using.

■ If your wireless router has security enabled, make sure you entered the WEP key or 
WPA passphrase correctly.

■ Remove and reinsert the CD to reinstall your product software.
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The product cannot find or connect to the wireless router 
access point

■ Try connecting to the wireless router or access point with your computer or another 
device to confirm that it is working correctly.

■ Make sure that the product is within range of your router or access point.

■ If your wireless router or access point doesn’t broadcast its network name (SSID), 
manually enter your wireless network name. If your wireless router or access point has 
wireless security enabled, you will also need to know what kind of security it is using.

The product does not appear in the printer window 
(Mac OS X)

Make sure the printer driver was installed correctly and that your computer’s TCP/IP 
settings are configured correctly.

Cannot print over the network

■ Make sure you set up your software properly for network printing.

■ Print a Network Status Sheet (see page 26) and verify that the network settings are 
correct.

■ When using TCP/IP, make sure the product’s IP address is set correctly for your 
network. If your network does not assign IP addresses using DHCP, you need to set 
the IP address manually.

■ For an Ethernet connection, make sure that the product is turned on, and that your 
router, access point, switch, or hub link LED for the port the product is connected to 
is on or flashing. If the link LED is off, try the following:

■ Make sure the Ethernet cable is securely connected to both the product and your 
router, access point, switch, or hub.

■ Try connecting to another port on your router, access point, switch, or hub.

■ Try connecting the product to another router, access point, switch or hub.

■ Try connecting the product to your router, access point, switch, or hub with 
another Ethernet cable.

■ Try printing from another computer on the network to see if the problem 
persists.
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WiFi light is on but you can’t print

■ Your router might not be assigning IP addresses automatically using DHCP. If it isn’t, 
you will need to set the product’s IP address manually. Make sure it is set correctly for 
your network. Contact your router manufacturer for assistance.

■ Make sure your firewall or security software is not set to block port 3629 (TCP/
UDP). Contact your firewall manufacturer for assistance.

Printing is slow or the print is cut off

Print a Network Status Sheet (see below) and check the signal strength. If it’s poor, try 
moving the product closer to your wireless router or access point. Avoid placing the 
product next to a microwave oven, 2.4 GHz cordless phone, or large metal objects such as 
a filing cabinet.

Cannot scan over the network

■ Epson Scan is not available in Mac OS X 10.6; see page 17 for scanning instructions.

■ If you cannot scan from the product’s touch panel, make sure you restarted your 
computer after installing the product software. Make sure Epson Event Manager is 
not being blocked by your firewall or security software.

■ If you are scanning a large document at high resolution, a communication error may 
occur. If the scan did not complete, lower the resolution.

■ If network communication was interrupted while starting Epson Scan, exit Epson 
Scan, and restart it after a few seconds. If Epson Scan cannot restart, turn the product 
off and on, and then try again. Check the Timeout Setting in EPSON Scan 
Settings. For details, see the Epson Scan Help.

Print a Network Status Sheet

1. Press Home, if necessary, press l or r to select Setup, then press OK.

2. Press u or d to select Wi-Fi/Network Settings, then press OK.

3. Press u or d to select Confirm Wi-Fi/Network Settings, then press OK.

4. Press x Start twice to print the status sheet.

Printing and Copying Problems

■ Make sure your paper is loaded printable side facedown (usually the whiter, brighter, 
or glossy side). Make sure paper is loaded under the edge guides.
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■ Make sure the type of paper you loaded matches the paper size and paper type settings 
on the touch panel when copying (see page 7) or when printing with your printer 
software (see page 11).

■ When scanning, position your original in the back left corner of the scanner glass. If 
the edges are cropped, move it away from the corner slightly.

■ You cannot print or copy when an ink cartridge is expended. Replace any expended 
cartridges before printing.

Paper Feeding Problems

■ If paper doesn’t feed correctly, remove the paper and fan the sheets, then reload them 
as shown on the Start Here sheet. Make sure paper is loaded under the edge guides.

■ Do not load too many sheets at once. You can load up to 100 sheets of letter- or A4-
size plain paper, 80 sheets of Bright White or Presentation Paper Matte, or 10 sheets 
of Premium Photo Paper Glossy (4 × 6 inch only). Load all other papers one sheet at a 
time. See your online User’s Guide for more information.

■ Do not load paper with holes punched in it.

■ If paper is jammed, follow these steps:

1. Open the scanner and remove paper as shown, including any torn pieces.

Caution: To prevent damage, avoid handling parts inside the printer.

2. Pull back on the tabs to remove the cover inside the product. Remove jammed 
paper, including any torn pieces.
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3. Reattach the cover and close the scanner.

4. You may also need to check other locations for jammed paper, such as the auto 
duplexer (on the back of the printer), the paper cassette, and underneath the 
printer. See the online User’s Guide for more information.

Print Quality Problems

■ Make sure the document is placed flat against the document table glass and your 
Epson printer is not tilted or placed on an uneven surface.

■ Load the paper printable side down (usually the whiter, brighter, or glossy side) in the 
cassette.

■ Make sure your paper isn’t damp or curled.

■ For the best print quality, use Epson papers (see page 5) and genuine Epson ink 
cartridges (see page 20).

■ Make sure the type of paper you loaded matches the paper size and paper type settings 
in your printer software (see page 14). 

■ If you notice light or dark bands across your printouts or they are too faint, run a 
nozzle check (see page 18) to see if the print head needs cleaning.

■ If you notice jagged vertical lines, you may need to align the print head. See the online 
User’s Guide for instructions.

■ The ink cartridges may be low on ink. Check your cartridge status and replace 
cartridges, if necessary (see page 21).

■ Clean the scanner glass with a soft, dry, lint-free cloth (paper towels are not 
recommended), or use a small amount of glass cleaner on a soft cloth, if necessary. Do 
not spray glass cleaner directly on the glass.
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Where to Get Help

Internet Support
Visit epson.com/support (U.S.) or epson.ca/support (Canada) for solutions to common 
problems. You can download drivers and documentation, get FAQs and troubleshooting 
advice, or e-mail Epson.

Speak to a Support Representative
Before you call Epson for support, please have the following information ready:

■ Product name (Artisan 730)

■ Product serial number (located on the back of the product and under the scanner)

■ Proof of purchase (such as a store receipt) and date of purchase

■ Computer configuration and description of the problem

Then call:

■ U.S.: (562) 276-4382, 6 AM – 8 PM, Pacific Time, Monday through Friday and
7 AM – 4 PM on Saturday

■ Canada: (905) 709-3839, 6 AM – 8 PM, Pacific Time, Monday through Friday

Days and hours of support are subject to change without notice. Toll or long distance 
charges may apply.

Purchase Supplies and Accessories
You can purchase genuine Epson ink and paper at Epson Supplies Central at 
www.epson.com/ink3 (U.S. sales) or www.epson.ca (Canadian sales). You can also 
purchase supplies from an Epson authorized reseller. To find the nearest one, call 800-GO-
EPSON (800-463-7766).
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Notices

Important Safety Instructions

Before using your Epson product, read and follow these safety instructions:

■ Be sure to follow all warnings and instructions marked on the product.

■ Use only the type of power source indicated on the product label.

■ Use only the power cord that comes with the product. Use of another cord may cause fires or 
electric shock. Do not use the cord with any other equipment. Make sure the power cord meets 
all relevant local safety standards.

■ The product’s power cord is for use with the product only. Use with other equipment may 
cause fire or electric shock.

■ Place the product near a wall outlet where the plug can be easily unplugged.

■ If you won’t be using the product for a long period, unplug the power cord from the electrical 
outlet.

■ Always turn off the product using the P On button, and wait until the P On light stops 
flashing before unplugging the product or cutting off power to the electrical outlet.

■ Avoid plugging the product into an outlet on the same circuit as a photocopier or air 
conditioning system that regularly switches on and off, or on an outlet controlled by a wall 
switch or timer.

■ Do not let the power cord become damaged or frayed. Place it to avoid abrasions, cuts, fraying, 
crimping, and kinking. Do not place objects on top of it and do not allow it to be stepped on or 
run over. Be careful to keep the cord straight at each end. If damage occurs to the plug, replace 
the cord or consult a qualified electrician. If there are fuses in the plug, make sure you replace 
them with fuses of the correct size and rating.

■ If you use an extension cord with the product, make sure the total ampere rating of the devices 
plugged into the extension cord does not exceed the cord’s ampere rating. Also, make sure the 
total ampere rating of all devices plugged into the wall outlet does not exceed the wall outlet’s 
ampere rating.

■ When connecting the product to a computer or other device with a cable, ensure the correct 
orientation of the connectors. Each connector has only one correct orientation. Inserting a 
connector in the wrong orientation may damage both devices connected by the cable.

■ Place the product on a flat, stable surface that extends beyond its base in all directions. It will 
not operate properly if it is tilted or at an angle.

■ Avoid placing the product in locations that are subject to rapid changes in heat or humidity, 
shocks or vibrations, or dust. Do not place the product near a radiator or heating vent or in 
direct sunlight. Do not place or store the product outdoors.

■ Keep the product away from potential sources of electromagnetic interference, such as 
loudspeakers or the base units of cordless phones.
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■ Allow space behind the product for the cables, and space above the product so that you can 
fully raise the document cover.

■ Leave enough space in front of the product for the paper to be fully ejected.

■ Leave enough room around the product for sufficient ventilation. Make sure the product is at 
least 4 inches (10 cm) away from the wall.

■ Do not block or cover openings in the product case or insert objects through the slots.

■ Do not use aerosol products that contain flammable gases inside or around the product. Doing 
so may cause fire.

■ Do not press too hard on the document table when placing the originals.

■ Do not open the scanner section while the product is copying, printing, or scanning.

■ Be careful not to trap your fingers when closing the scanner cover or scanner.

■ Do not touch the flat white cable inside the product.

■ Do not spill liquid on the product. Do not use the product near water. Do not use with wet 
hands.

■ Unplug the product and refer servicing to qualified service personnel under the following 
conditions: if the power cord or plug is damaged; if liquid has entered the product; if the 
product has been dropped or the case damaged; if the product does not operate normally or 
exhibits a distinct change in performance.

■ Adjust only those controls that are covered by the operating instructions. Except as specifically 
explained in your documentation, do not attempt to service the product yourself.

■ Never disassemble, modify, or attempt to repair the product by yourself, except as specifically 
explained in the documentation. Do not adjust controls that are not covered by the operating 
instructions.

■ When storing or transporting the product, do not tilt it, stand it on its side, or turn it upside 
down; otherwise ink may leak from the cartridges.

■ Always keep this guide handy.

Touch Panel Safety Instructions

■ Press the touch panel gently with your fingertip. Do not press with force or use your fingernail.

■ Do not use items such as ball point pens, pencils, etc. to operate the touch panel.

■ Do not place heavy items on the touch panel. Contact Epson if the panel chips or cracks; do 
not attempt to remove broken pieces.

■ Do not place your product in areas where abrupt changes in temperature or humidity may 
occur. Condensation inside the panel may cause performance to deteriorate.

■ Do not touch the panel with wet or gloved hands or through the protective sheet or sticker; it 
may not respond.

■ Use only a dry, soft cloth to clean the touch panel. Do not use liquid or chemical cleansers.
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■ If the touch panel is damaged, contact Epson. If the liquid crystal solution gets on your hands, 
wash them thoroughly with soap and water. If the liquid crystal solution gets into your eyes, 
flush them immediately with water. If discomfort or vision problems remain after a thorough 
flushing, see a doctor immediately.

Memory Card Safety Instructions

■ Use only compatible memory cards (see the User’s Guide for a detailed list).

■ Do not remove a memory card or turn off the product while the memory card light is flashing.

Wireless Network Safety Instructions

■ Do not use this product inside medical facilities or near medical equipment. Radio waves from 
the product may adversely affect the operation of medical equipment.

■ Keep this product at least 9 inches (22 cm) away from cardiac pacemakers. Radio waves from 
this product may adversely affect their operation.

■ Do not use this product near automatically controlled devices such as automatic doors or fire 
alarms. Radio waves from this product may adversely affect these devices.

Ink Cartridge Safety Instructions

■ Keep ink cartridges out of the reach of children.

■ Be careful when you handle used ink cartridges; there may be ink remaining around the ink 
supply port. If ink gets on your skin, wash it off with soap and water. If it gets in your eyes, 
flush them immediately with water. If ink gets in your mouth, spit it out and see a doctor right 
away.

■ Do not put your hand inside the product or touch any cartridges during printing.

■ Do not try to move the print head by hand, or you may damage the product.

■ Do not touch the green IC chip on the side of the cartridge. This may prevent normal 
operation.

■ Before transporting the product, make sure the print head is in the home (far right) position 
and the ink cartridges are in place.

■ Install a new ink cartridge immediately after removing a used one. Leaving cartridges 
uninstalled can dry out the print head and may prevent the product from printing.

■ Do not dismantle an ink cartridge. This could damage the print head.

■ Do not shake ink cartridges after opening their packages, and do not remove the label from the 
cartridge itself; this can cause leakage.

■ Use the ink cartridge before the date printed on its package.
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■ If you remove an ink cartridge for later use, protect the ink supply area from dirt and dust and 
store it in the same environment as the product. Note that there is a valve in the ink supply 
port, making covers or plugs unnecessary, but care is needed to prevent the ink from staining 
items that the cartridge touches. Do not touch the ink cartridge ink supply port or surrounding 
area. Store ink cartridges with their labels facing upward. Do not store cartridges upside down.

■ Store ink cartridges in a cool, dry place.

■ After bringing an ink cartridge in from a cold storage site, allow it to warm up at room 
temperature for at least 3 hours before using it.

Declaration of Conformity

According to 47CFR, Part 2 and 15 for: Class B Personal Computers and Peripherals; and/or CPU 
Boards and Power Supplies used with Class B Personal Computers:

We: Epson America, Inc.
Located at: MS 3-13

3840 Kilroy Airport Way
Long Beach, CA 90806
Telephone: (562) 290-5254

Declare under sole responsibility that the product identified herein, complies with 47CFR Part 2 and 
15 of the FCC rules as a Class B digital device. Each product marketed is identical to the 
representative unit tested and found to be compliant with the standards. Records maintained 
continue to reflect the equipment being produced can be expected to be within the variation 
accepted, due to quantity production and testing on a statistical basis as required by 47CFR §2.909. 
Operation is subject to the following two conditions: (1) this device may not cause harmful 
interference, and (2) this device must accept any interference received, including interference that 
may cause undesired operation.

Trade Name: Epson
Type of Product: Multifunction printer
Model: C432A

Epson America, Inc., Limited Warranty

What Is Covered: Epson America, Inc. (“Epson”) warrants to the original retail purchaser that the 
Epson printer covered by this limited warranty statement, if purchased and operated only in the 
United States, Canada, or Puerto Rico, will be free from defects in workmanship and materials for a 
period of one (1) year from the date of original purchase. For warranty service, you must provide 
proof of the date of original purchase.

What Epson Will Do To Correct Problems: Should your Epson printer prove defective during the 
warranty period, please call the Epson Connection at (562) 276-4382 (U.S.) or (905) 709-3839 
(Canada) for warranty repair instructions and return authorization. An Epson service technician will 
provide telephone diagnostic service to determine whether the printer requires service. If service is 
needed, Epson will, at its option, exchange or repair the printer without charge for parts or labor. If 
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Epson authorizes an exchange for the defective unit, Epson will ship a replacement printer to you, 
freight prepaid, so long as you use an address in the United States, Canada, or Puerto Rico. 
Shipments to other locations will be made freight collect. You are responsible for securely packaging 
the defective unit and returning it to Epson within five (5) working days of receipt of the 
replacement. Epson requires a debit or a credit card number to secure the cost of the replacement 
printer in the event that you fail to return the defective one. If Epson authorizes repair instead of 
exchange, Epson will direct you to send your printer to Epson or its authorized service center, where 
the printer will be repaired and sent back to you. You are responsible for packing the printer and for 
all costs to and from the Epson authorized service center. When warranty service involves the 
exchange of the printer or a part, the item replaced becomes Epson property. The replacement 
printer or part may be new or refurbished to the Epson standard of quality, and, at Epson's option, 
may be another model of like kind and quality. Exchange products and parts assume the remaining 
warranty period of your original product covered by this limited warranty.

What This Warranty Does Not Cover: This warranty covers only normal use in the United States, 
Canada, or Puerto Rico. Using this product for continuous production or similar high duty purposes 
is not considered normal use; damage, maintenance or service from such use will not be covered 
under this warranty. This warranty is not transferable. This warranty does not cover any color change 
or fading of prints or reimbursement of materials or services required for reprinting. This warranty 
does not cover damage to the Epson product caused by parts or supplies not manufactured, 
distributed or certified by Epson. This warranty does not cover ribbons, ink cartridges or third party 
parts, components, or peripheral devices added to the Epson product after its shipment from Epson, 
e.g., dealer or user-added boards or components. Epson is not responsible for warranty service should 
the Epson label or logo or the rating label or serial number be removed or should the product fail to 
be properly maintained or fail to function properly as a result of misuse, abuse, improper installation, 
neglect, improper shipping, damage caused by disasters such as fire, flood, and lightning, improper 
electrical current, software problems, interaction with non-Epson products, or service other than by 
an Epson Authorized Servicer. If a claimed defect cannot be identified or reproduced, you will be 
held responsible for the costs incurred.

THE WARRANTY AND REMEDY PROVIDED ABOVE ARE EXCLUSIVE AND IN LIEU OF 
ALL OTHER EXPRESS OR IMPLIED WARRANTIES INCLUDING, BUT NOT LIMITED 
TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT OR 
FITNESS FOR A PARTICULAR PURPOSE. SOME LAWS DO NOT ALLOW THE 
EXCLUSION OF IMPLIED WARRANTIES. IF THESE LAWS APPLY, THEN ALL EXPRESS 
AND IMPLIED WARRANTIES ARE LIMITED TO THE WARRANTY PERIOD 
IDENTIFIED ABOVE. UNLESS STATED HEREIN, ANY STATEMENTS OR 
REPRESENTATIONS MADE BY ANY OTHER PERSON OR FIRM ARE VOID. IN NO 
EVENT SHALL EPSON  OR ITS AFFILIATES BE LIABLE FOR ANY SPECIAL, 
INCIDENTAL OR CONSEQUENTIAL DAMAGES RESULTING FROM THE USE OR 
INABILITY TO USE THE EPSON PRODUCT, WHETHER RESULTING FROM BREACH 
OF WARRANTY OR ANY OTHER LEGAL THEORY.  IN NO EVENT SHALL EPSON OR 
ITS AFFILIATES BE LIABLE FOR DAMAGES OF ANY KIND IN EXCESS OF THE 
ORIGINAL RETAIL PURCHASE PRICE OF THE PRODUCT.

In Canada, warranties include both warranties and conditions.
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Some jurisdictions do not allow limitations on how long an implied warranty lasts, and some 
jurisdictions do not allow the exclusion or limitation of incidental or consequential damages, so the 
above limitations and exclusions may not apply to you. This warranty gives you specific legal rights 
and you may have other rights which vary from jurisdiction to jurisdiction.

To find the Epson Authorized Reseller nearest you, visit our website at: http://www.epson.com.

To find the Epson Customer Care Center nearest you, visit http://www.epson.com/support.

You can also write to: Epson America, Inc., P.O. Box 93012, Long Beach, CA 90809-3012

Copyright Notice

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or 
transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or 
otherwise, without the prior written permission of Seiko Epson Corporation. The information 
contained herein is designed only for use with this Epson product. Epson is not responsible for any 
use of this information as applied to other equipment.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or 
third parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result 
of: accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to 
this product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation’s 
operating and maintenance instructions.

Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any 
options or any consumable products other than those designated as Original Epson Products or 
Epson Approved Products by Seiko Epson Corporation.

In addition to software program rights owned by Seiko Epson Corporation, this product also 
includes open source software. Refer to OSS.pdf on your product software CD-ROM for a list of 
open source software and software license terms applied to this printer.

Responsible Use of Copyrighted Materials

Epson encourages each user to be responsible and respectful of the copyright laws when using any 
Epson product. While some countries’ laws permit limited copying or reuse of copyrighted material 
in certain circumstances, those circumstances may not be as broad as some people assume. Contact 
your legal advisor for any questions regarding copyright law.

Trademarks

Epson and Supplies Central are registered trademarks and Epson Exceed Your Vision is a registered 
logomark of Seiko Epson Corporation.

Artisan is a registered trademark and Epson Connection is a service mark of Epson America, Inc.



General Notice: Other product names used herein are for identification purposes only and may be 
trademarks of their respective owners. Epson disclaims any and all rights in those marks.

This information is subject to change without notice.
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